GEOG357: Remote sensing Lab 2
Unsupervised classification
General Goal:
This lab involves identifying land cover types by using algorithms to identify pixels with similar
multi-spectral Digital Numbers (DN) and spectral signatures

0. Starting
Connect to osmotar from your desktop/laptop using VPN2 (preferred) or VMware
Size the osmotar window for your display
In the osmotar desktop, if you haven't already you should create a new folder :
In the file manager window, right-click, and select new folder
I would name it
geog357
(no spaces)
In this lab, you will create new channels (layers) not just display existing bands, so you will need
your own copy of the files to write to:
Use the folder manager to copy these files and folders from /home/labs/geog357 into your
geog357 folder - the one you just created:
pg11sept1996.pix
pg3sept2013.pix
shapefiles (folder)

Notes on file and folder names
1. I try not to use paces in folder (or file) names
2. Keep them concise … GIS software has a letter limit when loading files from folders
3. Generally avoid upper case letters – think like a computer !

Start Geomatica Banff Focus
File-> Open .. your copy of pg11sept1996.pix
Size / expand your Banff window for your display
switch the display from Thematic Mapper bands 1-2-3 to 5-4-3 (layer → RGB Mapper)
and enhance using the root option

1- Bitmaps
Traditional analogue mapping from panchromatic aerial photography uses interpretation and
manual digitising. We'll simulate a digital process from one band ... this only works if a feature
type has a unique set of DNs. Water reflects almost no NIR and thus has very low DNs in L5 TM
Band 4 (L8 OLI Band 5). Extract water only - imagine you don't have a GIS layer for PG
Extract water only - imagine you don't have a GIS layer for PG.
Click around in the water and note the highest general DN for water in Band 4 (Near IR) –
numbers displayed in the green gun below the image - be sure not to catch any shoreline / mixed
pixels. Note (and avoid) the two algae masses in Tabor Lake.
You might want to zoom in a bit, maybe around the two rivers confluence (“T'enneh”).
We will use this DN to try to identify ONLY water via the Threshold algorithm:
Tools -> Algorithm Librarian -> click Find - and type THR (then enter)
It will find the algorithm and then click Open
To reduce clutter, you might want to close the algorithm librarian window.
Tick channel 4 .... the bottom panel should be checked on 'viewer'
click on the Input params tab, enter 0 for minimum and a conservative value for water as
maximum - go low at first below your estimated value, e.g. 12 so it’s easier to 'up' it
- click the Log tab and then Run (the screen shows the progress or errors)
Some (but not all) water should fill with a default colour – likely red.
Now up your maximum (Input params) to a value close to your estimated value and run again
Is all the water now filled ? click on a coloured area and non-coloured area - below it should
indicate DN of 1 and 0 (water and land).
if some water areas are not coloured, highlight the layer on the left (in maps tab) and query the
water DNs (Band 4).. possibly some water pixels are a bit higher; maybe you need to increase
the maximum a bit more to cover these, but notice the bitmap starts to include shadows on the
north side of the eskers north of the Nechako River.
−
IMPORTANT POINT: when you read the DN values at bottom, they apply to whichever display
layer you have active – it may not be the top one. Just as in GIS software, highlight the layer you
are trying to query to be sure. If the active layer is the image, you see the 3 band DNs; if the
bitmap above it is the layer, you will see 1 (water) or 0 (land)
Eventually, you should find a value that hits just water and most of it – if you go too high, it
starts to fill in non-water, but there is no perfect DN – either some water gets omitted or some
non-water gets included. Record what this value is (it will be an answer you will need later)
Once you have your best number value, Go back to the first tab (files) in THR
check the box below viewer, hit browse and navigate to your copy of pg11sept1996.pix
Run again, and this time it will add a bitmap (1 or 0) = water or land to your file.
It is NOT overwriting your file, just adding a bitmap to it
NEVER NEVER NEVER accept the useless default of ‘untitled.pix’

Check by switching from maps to files in the TOC (table of contents), and this should list a
bitmap as well as the rasters; switch back to the maps tab.
The .pix file contains all layers – it’s not like an Esri shapefile, more like a geodatabase (gdb)
Compare the bitmap with the city rivers GIS layer, loading it as you did last time:
Layer-add->vector and navigate to your shapefiles folder - select rivers.shp and the VEC layer
Turn the bitmap on and off so you can see the vectors; they are not identical as the vectors were
produced from higher resolution air photos, and may be more up to date than 1996.
But wasn't that easier than manually digitising the rivers and lakes.. !? (maybe less accurate)
Display tidy-up .. you likely have several temporary display layers, and all we need now is the
original 543 display, so right-click and remove from area all other layers listed. Make sure you
are in 'maps' not 'files' or you would delete your bitmap.

2. Classification Introduction
Classification involves identifying a set of unique spectral signatures for a feature type in the
image scene. We want our classifier to take advantage of maximum information content
available in the image, so we will choose relatively uncorrelated bands to run the classification
e.g. 5-4-3 and NOT 3-2-1
BAND CORRELATION
You should notice the following for Landsat TM data:
1. VIS (visual) bands show cultural features and in detail
2. NIR shows the land/water boundary sharply. Water appears black
3. MIR shows dryness or inverse of moisture (high DN = low moisture)
4. TIR shows basic variations in temperature (though we won't use this)
Ensure you are zoomed out to show the full extent – symbol to left of zoom options
To view correlation between any selected band pair, Select layer -> scatterplot
Look at the correlation between the following bands. The more correlated the bands, the closer
the plotted points fall along a straight line (one band is nearly a linear function of the other).
Green v Red r = 0.95
Green v NIR
NIR v MIR r = 0.71
Blue v TIR
NIR v TIR
MIR1 v MIR2 (5 v 7)
you should see a high 'r' between visible bands, and less with IR (except maybe 5 v 7)
r values correspond to the image data displayed – values will vary if you are zoomed in
what is the r value between the red and near-IR bands ? (note it down – you will need it)
Review also the histograms: layer → histograms

This displays the 3 bands in the composite and represent the VIS, NIR and MIR. Click on each
histogram to expand each one at a time: higher SD = higher contrast
The standard deviation value is an indication of data spread (lower for VIS), and the bimodal
graphs for IR reflect the very low DNs for water.

3. Unsupervised Classification algorithms
You will now see the difference between a band (recorded by the sensor) and a channel – which
can store a band, but also any other data generated by the user. We will add empty layers 8-bit channels which can store classification results with up to 256 classes.
You are ready to classify:
•
•
•
•
•
•
•
•
•

•

Analysis -> Image Classification -> Unsupervised
Select the file to use = your .pix file
Select New session
Click on add layer and add five (5) more 8-bit layers (channels)
We need to specify the display, input bands and output CHANNEL
Select TM bands 5,4,3 (R, G, B) as input channels (and tick in input column)
The colour ticks in the first 3 columns are simply what is displayed
Select the first empty channel (8) as output
NOTE: the designated output channel will be overwritten, so if you specify a band
number (1-7) you will LOSE the band data - so always double check output channel
number - it should be an empty channel. Every year someone wipes out their data –
Don’t let it be you! (but it is recoverable)
click OK

In the Classify window, select these options:
• Algorithm: K-Means
• Max class: 5
• Max Iteration: 5
• Min Threshold: leave as is
• Max Sample Size: leave as is (with a bigger scene, we might specify a subset)
• Show Report button: 'on' (depressed)
• OK
.. this shows the report for the 5 clusters, # of pixels in each, and average DNs for bands 3,4,5
.. image displays in 'PC' (pseudo-colour), the new DNs are 1-5 (one number for each class)
This report could be saved if needed for future work (but is not needed here)
Can you visually identify the clusters as classes approximately? (do a quick check)
tick the PC (classification layer) off and on to view the classification and the 543 composite.
View the report also - it gives the number of pixels in each class, and the mean DNs
It should be poor as there are too few classes - and iterations

Right-click the Classification MetaLayer and select run classification
Change the number of classes (clusters) to 10 - view the result, its better, but view the
classification report - likely there are only 6-7 clusters containing most of the data
Right-click the Classification MetaLayer again and select run classification
Change iterations also to 10 - view the result, now most clusters have pixels
review the report stats: Which is the band (3, 4 or 5) that most differentiates water and forest –
– it might be a bit obvious, and why ? (note down your answer)
Once more, Right-click the Classification MetaLayer and select run classification
This time, try 16 classes/clusters and run classification again. This should seem better – click
classification Metalayer off and on to compare with the image
Can you match the cluster numbers with land cover types - click each colour to see which cluster
it is, and try to visually match these against the list below.
Change the colours for easier reading if you wish - at the very least make the water cluster class
blue, and coniferous forest dark green: expand ‘output’ checkmark and double-click on the
legend colours to edit them.
Note that some shadows get grouped with water – the north facing slopes of the esker ridges
north of the Nechako River; next week we will see how this can be corrected.
Some cluster classes may be 'hybrid' or mixed, e.g. grassy areas could be regenerating cut areas,
city parks, etc.. the bottom 3 clusters may intermix
See which cluster numbers correspond to:
• Water
• Conifers
• Deciduous trees
• Industrial – urban
• Residential - urban
• Grass (e.g. soccer fields)
• Agricultural fields
• Cutblocks
You will likely find the last numbered clusters cover the Canfor chip piles - these have the
highest DNs in the TM bands (like snow in the mountains!) and no other similar features

Fuzzy k-means
Select Analysis -> Image Classification -> Unsupervised
( …. new session, and pick an empty channel for the output – 9 (input = 543 as before)
Go for 16 / 16 in the clusters and iterations - how does this compare with the previous K-means?
Does it do any better in mapping the classes above? Hard to tell with different colour tables.
Note that it runs slightly slower because the clustering process includes the spread of pixels in
each cluster and probability functions, not just which seed point / mean each pixel is closest to.

ISODATA classifier
Select Analysis -> Image Classification -> Unsupervised
( …. new session, and pick an empty channel for the output – 10 (input = 543 as before)
Now select Isodata as the method. This time, you can make all options 16 minimum clusters,
maximum, and desired clusters and 16 iterations. Again view the result, and the classification
report - almost all clusters should have a fair number of pixels (or the clusters are 'wasted'), and
compare with the previous classifications.
In order to display both or all 3 classifications, select layer->add->pseudocolour,
and select the previous classification channel (fuzzy k-means) – the software should have
labelled them suitably. Click the fuzzy / isodata layers off /on to compare with the underlying
colour composite … it may be hard to objectively tell, but for me the isodata slightly retains
homogenous areas within the same class – not very scientific, but hey it's only a lab !
Select which you think is the best classification of the ones you've tried for the next step - i.e.
'maps' a given class to your satisfaction.... this is quite subjective - for a project or job, you'd
spend more time on this. Check for example which one separates the residential areas in the bowl
versus the light industrial areas (more purple in the 543 composite).
Classify once more Analysis -> Image Classification -> Unsupervised
but this time we'll add bands 2 and 7 as extra input as some people advocate using all bands,
tick channel 11 for output and pick 543 as display, but tick 2,3,4,5,7 for input - you are not
limited to 3 input bands, only visual display. Use your best algorithm (K-means, Fuzzy, or
Isodata). Has it done any better than with only 3 input bands? hard to tell – I didn't think so.
Some researchers also think too many inputs can 'confuse' the algorithm.

4. Filtering / sieving the classification
The classification will have isolated pixels, which are mostly undesirable 'noise'
These can be reduced using the SIEVE algorithm
In your 'favourite' classification, first note - what is the cluster number(s) for water .. this is so
you can retain small lakes, as they may be meaningful. Make sure you are viewing/checking the
correct layer.
Tools -> Algorithm Librarian
click the 'Find' button and type in sieve and then 'Open' the same as with Threshold (THR).
The parameters will be these:
input = ## (the channel number your best classification )
output port should be viewer -PCT (at first)
Let's do a small sieve – 1 acre which is ~ 4 pixels (1 acre is about 60x60m)

Input params:
Polygon size threshold= 4
Connectedness - can be 4 or 8
exclude values list = ## (where ## is the class number for water)
select log tab and run ...
View the result, compared with the unsieved classification - click the sieve on and off and you
should see the before and after
If suitable, now save - run it again, specify your filename under the 'files' tab in sieve, as output
at the bottom - make sure you select your copy of pg11sept1996.pix. This is now saved as a new
channel in your file - check which one it is, by viewing your list of channels in the main tab on
the left of the image, under 'Files' and expand the rasters list.
NOTE (again): NEVER accept the default filename 'Untitled.pix'. You must have all your data
layers in the same file. and you should not have any file named Untitled.pix in your folders …

5. Prince George 2013 Landsat 8 scene
The Landsat 8 Operational Land Imager (OLI) has 16-bit data … DNs can range from 0-65,535
(but rarely do). Since 2013 both NASA Landsat and ESA Sentinel programs have 16 bit data, so
we should get used to it in labs. We could add the newer image to this 'project' but it's likely less
confusing to start a new project – you can save the other one if you like e.g. pg1996 (.gpr)
Display (open) the 2013 image, using the Mid-IR, Near IR – Red combination – it has the extra
band 1 (coastal blue), so the optimal combination is now 654 instead of 543 for Landsat 5.
1. Bitmap – create the water bitmap same as you did for the 1996 image, of course you’ll need a
very different threshold value – record this value
2. Classification Intro: try the same scatterplot combinations as with the 1996 image– are the r
values very different ? What is the r value for Red versus Near-IR ?
Check the 654 histograms for 2013 and review the range of DNs for the near-IR band
How do you interpret the double minor modal peaks for low DNs in the histogram ?
3. Classification algorithms – no need to repeat everything – just do the one which you felt
worked best – no prizes on this, it’s an intro lab, not a project or thesis. You’ll only need to
create one new 8-bit channel for classification. I found the Isodata ran best (16 classes).
Has the 16-bit image data helped better distinguish between water and the esker shadows ?
Possibly notice it’s picked out more apparent detail due to the higher radiometric resolution.

Lab assignment 1
Assignment questions are designed to enhance your understanding of RS data, display and
classification. Send your answers either as an email attachment or in the message to:
wheate@unbc.ca by Wednesday 30 September (6pm).
Note: there’s no need to rewrite the question in your answer, just send in note form.
These questions were posed earlier in the lab; here they are summarised:
1. What maximum threshold values did you determine for water for

a. 1996 and b. 2013

2. What is the correlation value (r) between Red and NIR for a. 1996 and b. 2013
3. What were the (max) threshold values you used to create the water bitmaps: a. 1996 b. 2013
– Ooops, same question as #1 !!
4. The classifier often is challenged separating water from dark coniferous forest.
Using either image, which one of the three bands displayed shows the biggest difference between
these two features and explain why – click in water and forest and view the DN values).
5. Some interpretation on the 8 bit (1996) versus 16 bit (2013) data:
a. How do you interpret the double minor modal peaks for low DNs in the 2013 histogram ?
b. Has the 16-bit image data helped distinguish between water and the esker shadows ?
- how much and why or why not ?
Next week's lab: Supervised Classification

